About Office Proofing Tools
Microsoft Office 2003 Proofing Tools is a collection of tools— such as
spelling and grammar checkers, thesauri, and AutoCorrect lists— that
help you create and edit Office 2003 documents in the language of your
choice.
Your language version of Office 2003 might already include built-in
proofing tools for several languages. For example, the English version of
Office includes proofing tools for English (U.S., U.K., Canada, and
Australia), Spanish, and French (France and Canada). With the Office
Proofing Tools, you get the same capabilities and more for over 40
languages.
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What's included with Office Proofing Tools
When you install Microsoft Office 2003 Proofing Tools, the following
proofing tools are added to Microsoft Office 2003 programs:
Spelling checkers and their accompanying dictionaries
Grammar and writing style checkers
Thesauri
Hyphenators
AutoCorrect lists
AutoSummarize capabilities
Translation dictionaries
In addition to the basic tools, Office Proofing Tools includes the following
utilities, which are particularly useful if you work with East Asian, Indic,
right-to-left, or South Asian languages:
Input Method Editors (IMEs) for Simplified Chinese, Traditional Chinese,
Japanese, and Korean
Word breakers, for languages that don't use blank spaces to delineate
words
Text converter for Simplified Chinese and Traditional Chinese
Japanese Consistency Checker
Phonetic guides
Hangul Hanja converter for Korean
Hanja dictionary for Korean
Sequence checker for Indic and South Asian languages
Bilingual dictionaries
Fonts
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About fonts provided with Office and Office Proofing Tools
Microsoft Office 2003 and Microsoft Office 2003 Proofing Tools include
the fonts necessary for working with text in various languages.
Many of the TrueType fonts provided with Office 2003 support a wide
variety of languages that use different writing systems, such as Greek or
Russian, rather than just the languages of Western Europe. Office
includes a few fonts for East Asian languages as well.
The font Arial Unicode MS provided with Office is a full Unicode font,
containing most of the approximately 40,000 alphabetical characters,
ideographic characters, and symbols defined in the Unicode standard.

Proofing tools included for each language
The following table lists the tools that Microsoft Office 2003 Proofing
Tools includes for each language. Some proofing tools are available only
in specific Microsoft Office programs and for specific languages.
Grammar
Spelling and Style
AutoCorrect
Languages Checkers Checkers Thesauri Lists
AutoSummarize
Arabic
X
X
X
X
Basque
X
X
Bulgarian X
X
Catalan
X
X
X
Chinese
X
X
X
(Simplified)
Chinese
X
X
X
(Traditional)
Croatian
X
X
X
Czech
X
X
X
Danish
X
X
X
X
Dutch
X
X
X
X
English
X
X
X
X
X
Estonian
X
X
X
Finnish
X
X
X
X
French
X
X
X
X
X
Gaelic
X
(Ireland)
Galician
X
German
X
X
X
X
X
Greek
X
X
X
Gujarati
X
X
X
Hebrew
X
X
X
Hindi
X
X
X
Hungarian X
X
X
X

Icelandic
Indonesian
Italian
Japanese
Kannada
Korean
Latvian
Lithuanian
Marathi
Norwegian
(Bokmål)
Norwegian
(Nynorsk)
Polish
Portuguese
(Brazil)
Portuguese
(Portugal)
Punjabi
Romanian
Russian
Serbian
(Cyrillic)*
Serbian
(Latin)
Slovakian
Slovenian
Spanish
Swedish
Tamil
Telugu
Thai
Turkish

X
X
X
X
X
X
X
X
X

X
X

X
X

X

X

X

X

X
X
X
X
X
X
X
X

X
X

X
X

X
X

X

X

X

X

X
X

X
X
X
X

X

X
X
X
X
X
X
X
X
X

X

X

X
X

X
X
X
X

X
X

X

X

X
X

X

X
X
X
X
X

X

X
X
X
X
X
X
X
X

X
X

Ukrainian X
Vietnamese X
Welsh
X

X

X
X

* The Office 2003 Proofing Tools Setup Wizard provides an installation
option only for Serbian (Latin). If you select that option during setup, the
wizard installs proofing tools for both Serbian (Cyrillic) and Serbian
(Latin).

About the Unicode text encoding standard
Microsoft Office is based on the Unicode text encoding standard, a
standard that governs character encoding and provides a 16-bit
extensible international character coding system for information
processing that covers the world's major languages. The Unicode
standard defines character encoding and the properties and algorithms
that are used in its implementation. For more information about the
Unicode standard, see the Unicode Consortium Web site at
http://www.unicode.org.
The use of Unicode in Office allows Office programs to display
documents correctly, no matter which language they are written in,
provided that the operating system supports the characters specific to
that language.
Because Office programs are based on the Unicode text encoding
standard, you can use them to open and save files in encoding standards
for many different languages by using the internal Unicode encoding as
the interchange format. For example, you can use Microsoft Word to
open a text file encoded in a Greek or Japanese encoding standard on
your English-language system.
When you create a Web page by using an Office program, you can set
the encoding for the Web page. If you create a Web page in another
language, it's a good idea to change the encoding of the page to match
the language you use. This minimizes its size and ensures that it can be
viewed in older Web browsers. The UTF-8 encoding is a reasonably
compact encoding standard for any language, but only version 4
browsers and later support it.
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About accessibility aids
In addition to the features and resources described in Help, other
products, services, and resources for people with disabilities are
available from Microsoft. The Microsoft Accessibility Web site at
http://www.microsoft.com/enable provides information about accessibility
aids, or assistive technology products, to help improve the lives of people
with disabilities by making computers a positive force in employment,
education, and recreation. The information on the site benefits people
with disabilities and their friends and family members, people in outreach
organizations, educators, and advocates.
Because a wide variety of accessibility aids are available, the Microsoft
Accessibility Web site also provides a searchable catalog of accessibility
aids that run on Microsoft Windows operating systems. Some of the
different types of products available for Windows operating systems are:
Programs that enlarge the information displayed or alter the color of
information on the screen for people with visual impairments.
Programs that describe information on the screen in Braille or
synthesized speech for people who are blind or have difficulty reading.
Hardware and software utilities that modify the behavior of the mouse
and keyboard.
Programs that enable people to type by using a mouse or their voice.
Word or phrase prediction software that allows people to type more
quickly and with fewer keystrokes.
Alternative input devices, such as single switch or puff-and-sip devices,
for people who cannot use a mouse or a keyboard.
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Accessibility features in Help
Some of the content in this topic may not be applicable to some
languages.
Microsoft Office 2003 Proofing Tools Help includes features that make it
accessible to a wider range of users, including those who have limited
dexterity, low vision, or other disabilities.
Keyboard shortcuts for using the Help window
Changing the appearance of Help topics
Using expandable links to view information in a Help topic
Additional features in Microsoft Office Help
Help for each of the Microsoft Office 2003 programs provides all of the
accessibility features available in Office 2003 Proofing Tools Help as well
as the following features.
Keyboard shortcuts for using the Help task pane
Keyboard shortcuts for using the Ask a Question box

Using screen readers with Help
Some screen readers may not work with the expandable links in online
Help. If you're having problems, try one of the following:
Expand all the links in the topic by using the Show All button at the top of
the topic.
Install Microsoft Internet Explorer 6. For more information, visit the
Microsoft Internet Explorer home page at
http://www.microsoft.com/windows/ie.
Download the accessible Help files. For more information, visit the
Microsoft Office Online Web site at http://office.microsoft.com.

Accessibility features in Office Proofing Tools
When you install Microsoft Office 2003 Proofing Tools, its features are
integrated with Microsoft Office 2003 programs. This means that, in
general, Office accessibility features such as keyboard access also apply
to Office Proofing Tools after it is installed.
The following are highlights of some features that make Office more
accessible for people with disabilities. For more information about
accessibility features in Office, see Help in any of the Office programs.
Changing the size or magnification of text or objects To make
information more readable on the screen, you can change the
magnification of a document, worksheet, database object, or other file in
any Microsoft Office program. You can also make toolbar buttons larger
so that they're easier to see and use.
Customizing toolbars and menus If you use only a subset of toolbar
buttons and commands, you can create a toolbar that contains only the
buttons and menus you use most often. You can also group toolbar
buttons and menu commands together in a way that makes the most
sense to you. You can even create a custom toolbar button or menu
command.
Using keyboard shortcuts in Office programs Many features of
Office programs are available directly from the keyboard. If a command
you want doesn't have a shortcut key, you can assign one to quickly gain
access to the command.
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About creating accessible Office documents
If you use Microsoft Office programs to design presentations, Web
pages, and other types of documents, you should make sure that the
content you create is accessible to all people, including those with
disabilities.
These tips illustrate just a few ways to create accessible content:
If you design Web pages or HTML-based documents, be sure to add
alternative text to any graphics you use. Web browsers display
alternative text while pictures are loading or if they are missing.
Alternative text helps users who have graphics turned off in their browser
or users who rely on screen review utilities to interpret information on the
screen.
Don't rely on sound alone to convey important information. For example,
if your Microsoft PowerPoint presentation contains audio, you can make
text descriptions of the audio content available as part of the slide, in the
notes pane. Making audio information available in an alternative form
benefits users who don't have a sound card or who have sound turned
off, or users who are deaf or hard-of-hearing.
Don't rely on color alone to convey important information. For example, if
your Microsoft Excel spreadsheet contains a color-coded chart legend,
use additional cues, such as textual annotations, to supplement the use
of color. Users may use a limited color scheme, or use a handheld
computer with a monochrome display, or rely on screen review utilities,
and these seldom convey information that is only represented by colors.
If you have access to the Web, you can learn more about creating
accessible content for Web pages by referring to the accessibility
standards developed by the World Wide Web Consortium. To learn more
about accessibility in Microsoft products, visit the Microsoft Accessibility
Web site at http://www.microsoft.com/enable.

Get assistance from Microsoft Product Support Services
Product
Name
Support
Options

Microsoft Office Proofing Tools

Please see the Product Support Web site at
http://support.microsoft.com for the latest details on your
support options, or call (425) 635-7056 in the U.S. for more
information. In Canada, the latest support options can be
found on the Web at http://www.microsoft.ca/support, or call
PSS-Canada at (905) 568-2294. Microsoft text telephone
(TTY/TDD) services are available at (425) 635-4948 in
Washington state or (800) 892-5234 in the U.S. Call (905)
568-9641 in Canada.
Worldwide Support options, hours and cost in your country or region
may differ from the US. Please check with your local office
for details.
Conditions Microsoft support services are subject to then-current
prices, terms, and conditions, which are subject to change
without notice.

Product Support for Office Proofing Tools Customers
Do you need support for Microsoft Office Proofing Tools? You can access
a wealth of no-charge* self-help resources online at
http://support.microsoft.com. If you need to speak with a Support
Professional, please call Microsoft Product Support Services*. If you
represent a large organization, please visit our support resources page
for managed support options that may be right for you.
International Support Support outside the U.S. and Canada may vary.
For regional contact details, visit
http://support.microsoft.com/international.aspx. Phone numbers for
Microsoft subsidiaries are subject to change. If there is not a Microsoft
support subsidiary in your country or region, please contact the
establishment from which you obtained your Microsoft product.
* Connection charges may apply

Additional Support Options
Microsoft Certified Support Centers Our Microsoft Certified Support
Centers are selected for their ability to provide high-quality support and a
full range of support services for organizations using Microsoft products
in all kinds of environments. Certified Support Centers provide the
highest-quality service for both Microsoft products and a wide range of
third-party products to ensure a cohesive, high-performance business
solution.
For more information, see http://support.microsoft.com.
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System requirements
To install and use Microsoft Office 2003 Proofing Tools, you need:
Any language version of a Microsoft Office 2003 suite or individual
program that supports Office 2003 Proofing Tools.
For each language, except East Asian languages, approximately 20
megabytes (MB) of available hard disk space, in addition to the hard disk
space used by your Office program or programs.
For each East Asian language, approximately 240 MB of available hard
disk space, in addition to the hard disk space used by your Office
program or programs. This additional disk space requirement is for the
fonts, Input Method Editors (IMEs), and other tools designed specifically
for East Asian languages.
All other system requirements are the same as for the Office 2003
program or programs that you're using.
Note The hard-disk space requirement also varies according to the
Office 2003 Proofing Tools components you choose to install. In addition,
if you choose to install components on first use instead of all at once, the
hard disk space requirement is typically smaller, depending on which
components you use.

Install Office Proofing Tools
When you install Microsoft Office 2003 Proofing Tools, the proofing tools
— for example, dictionaries and thesauri— are added to each of your
Microsoft Office 2003 programs. You do not start Office 2003 Proofing
Tools as a separate program; instead, new tools for working in various
languages appear as dialog box options or menu commands in your
Office programs.
Insert the Microsoft Office 2003 Proofing Tools CD-ROM into your CDROM drive.
After a moment, the Microsoft Office 2003 Proofing Tools Setup Wizard
appears. Follow the instructions in the setup wizard to install Office 2003
Proofing Tools.
If the wizard doesn't appear, do the following:
1. On the Microsoft Windows Start menu, click Run.
2. In the Open box, type the letter of your CD-ROM drive, followed
by a colon and a backslash, followed by ptksetup.exe.
For example, if your CD-ROM drive is D, type d:\ptksetup.exe.
3. Click OK.
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Install system support for one or more languages
Microsoft Office 2003 and Microsoft Office 2003 Proofing Tools install
many of the files you need to proof text in other languages. However, if
you use a language version of Microsoft Windows 2000 or Windows XP
that doesn't match the language you want to work in, you might need to
install additional system support for that language.
Install system support for one or more languages in Windows XP
Install system support for one or more languages in Windows 2000

Enable editing for one or more languages
When you enable editing for a language, special features for working in
that language become available in Microsoft Office 2003 programs. For
example, if you install the English version of Office and enable editing for
Japanese, commands for formatting Japanese text appear on the
Format menu in Microsoft Office programs such as Microsoft Office
Word 2003, Microsoft Office PowerPoint 2003, and Microsoft Office
Excel 2003— and in other places throughout the programs— just as they
appear in the Japanese versions of those programs.
1. Close all open Office programs.
2. On the Microsoft Windows Start menu, do one of the following:
In Windows XP, point to All Programs, point to Microsoft
Office, point to Microsoft Office Tools, and then click
Microsoft Office 2003 Language Settings.
In Windows 2000, point to Programs, point to Microsoft Office
Tools, and then click Microsoft Office 2003 Language
Settings.
3. On the Enabled Languages tab, under Available Languages,
click the language you want to enable, and then click Add.
4. Repeat step 3 for each language you want to enable editing for.
Note After you enable editing for a language, you may need to install
system support and the correct keyboard layout for that language.
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Install fonts that support multiple languages
In most cases, Microsoft Office 2003 Setup automatically installs or
updates the fonts that support different languages, but in some cases
— such as Arial Unicode MS— you may need to install them yourself.
Note If you are using Microsoft Windows XP, Arial Unicode MS, the
universal font for Unicode, is automatically installed.
In addition, when you enable editing for East Asian, right-to-left, or
complex script languages, one or two fonts will be installed per language.
Installing Microsoft Office 2003 Proofing Tools sometimes adds an
additional font for each East Asian, right-to-left, or complex script
language already enabled for editing.
Install additional Office fonts on Windows XP
Install Arial Unicode MS and additional Office fonts on Windows 2000
Install additional Office Proofing Tools fonts on Windows XP
Install additional Office Proofing Tools fonts on Windows 2000
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Install and display an Input Method Editor (IME)
By using an Input Method Editor (IME), you can enter East Asian text in
Microsoft Office documents. An IME converts your keystrokes into East
Asian characters. You can then review the results of the conversion and,
if correct, insert the converted text into a document. Microsoft Office 2003
Proofing Tools includes IMEs for Simplified Chinese, Traditional Chinese,
Japanese, and Korean.
Install an IME on Microsoft Windows XP
Install an IME on Microsoft Windows 2000
Display an IME
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Use a keyboard layout for a specific language
You can use specialized keyboard layouts to type text in specific
languages. If you have more than one keyboard layout installed, you can
switch between them.
Install keyboard layouts for specific languages in Windows XP
Install keyboard layouts for specific languages in Windows 2000
Switch keyboard layouts
Note To type East Asian text, you must use an Input Method Editor
(IME) instead of a traditional keyboard.

About basic proofing tasks
Your language version of Microsoft Office 2003 or an Office 2003
program may already include tools for proofing text and performing other
proofing-related tasks for text in several languages. For example, the
English version of Office includes proofing tools for English, French, and
Spanish. When you install Microsoft Office 2003 Proofing Tools, you can
perform these tasks in many other languages.
Office Proofing Tools provides tools for working in:
East Asian languages— for example, Simplified Chinese, Traditional
Chinese, Japanese, and Korean
European languages— for example, French, German, Italian, and
Portuguese
Indic languages— for example, Gujarati, Hindi, Kannada, Punjabi, and
Tamil
Right-to-left languages— for example, Arabic, Hebrew, Farsi, and Urdu
South Asian languages— for example, Thai and Vietnamese
The proofing tools include spelling checkers, grammar and style
checkers, thesauri, hyphenation, AutoCorrect and AutoSummarize
support, and translation dictionaries. Note that some of these tools may
not be available, depending on the Office program you are using and the
language you are working in.
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About checking spelling
After you install Microsoft Office 2003 Proofing Tools, you can check the
spelling of text in different languages the same way you check the
spelling of text in your language. However, in some Microsoft Office 2003
programs, you must first select the spelling dictionary for the language in
which you want to check spelling. For information about changing the
spelling dictionary and checking the spelling of text in a different
language by using an Office program, see Help for that program.
Note The spelling checker may not be available, depending on the
Office program and language you are working in.
In Microsoft Office Word 2003, you can allow Word to select the correct
language dictionary automatically, so that you can check the spelling of
text as you type. To do so, do the following:
1. Enable editing for the language.
2. Turn on automatic language detection.
3. Make sure the correct language dictionary is installed.
Tip

About checking grammar and writing style
In Microsoft Office Word 2003, you can check the grammar and writing
style of text in a document according to the rules of a different language.
You can do so all at once or automatically as you type.
Before you can check the grammar and writing style of text automatically
as you type, you must do the following:
1. Enable editing for the language.
2. Turn on automatic language detection.
For information about checking grammar and setting the writing style in
Word, see Word Help.
In addition to checking grammar and writing style by using Word, you can
check the grammar of Japanese text by using Microsoft Office
PowerPoint 2003.

About AutoCorrect
By using AutoCorrect in a Microsoft Office 2003 program, you can quickly
correct common typos, misspelled words, grammatical errors, and
incorrect capitalization in a document. After you install Microsoft
Office 2003 Proofing Tools, you can automatically correct text in several
other languages the same way you correct text in your language.
To use AutoCorrect for a specific language in Microsoft Office
Word 2003, do the following:
1. Enable editing for the language.
2. Turn on automatic language detection.
For other programs, AutoCorrect follows the language property of the
keyboard that you're using, so be sure to install and switch to the
keyboard layout for the language that you want to type in.
For information about using AutoCorrect and customizing AutoCorrect
lists for an Office program, see Help for that program.

About hyphenation
You can use the hyphenation feature in Microsoft Office Word 2003 and
Microsoft Office Publisher 2003 to give your documents a polished and
professional look. For example, hyphenation helps eliminate gaps in
justified text. It also helps maintain even line lengths in narrow columns.
You can hyphenate text in a document all at once or automatically as you
type.
After you install Microsoft Office 2003 Proofing Tools, you can hyphenate
text in most languages. First you need to enable editing for the language
you want to work in. If you want to automatically detect the language and
hyphenate text as you type, you also need to turn on automatic language
detection. For information about hyphenating text automatically, see
Word or Publisher Help.

About thesauri
Microsoft Office 2003 Proofing Tools provides thesauri that you can use
to find synonyms and antonyms for words in a number of different
languages. Depending on the language you are working in, a thesaurus
may be available in the following programs: Microsoft Office Excel 2003,
Microsoft Office OneNote 2003, Microsoft Office PowerPoint 2003,
Microsoft Office Publisher 2003, and Microsoft Office Word 2003. Those
programs provide support for both the thesauri included with Office 2003
Proofing Tools and thesaurus services on the Internet.
To use a thesaurus for another language, first enable editing for the
language. Then type text in the language you want to work in, and look
up words in the thesaurus as usual. In Office Word 2003, you can
additionally turn on automatic language detection, which allows the
program to detect the language automatically as you type.
For information about finding synonyms or antonyms by using a specific
Office 2003 program, see Help for that program.

About translating text
Microsoft Office 2003 Proofing Tools provides translation dictionaries for
several languages. You can use these dictionaries to look up text in the
dictionary of a different language or to translate text from one language to
another.
Depending on the language you are working in, the translation
dictionaries may be available in the following programs: Microsoft Office
Excel 2003, Microsoft Office OneNote 2003, Microsoft Office
PowerPoint 2003, Microsoft Office Publisher 2003, and Microsoft Office
Word 2003. Those programs provide support for both the translation
dictionaries included with Office 2003 Proofing Tools and translation
services on the Internet.
For information about translating text by using a specific Office 2003
program, see Help for that program.

About AutoSummarize
AutoSummarize identifies the key points in a Microsoft Office Word 2003
document so that you or other readers can quickly scan the information in
the document. It does so by analyzing the document and assigning a
score to each sentence. Sentences that contain significant words used
frequently in the document, or phrases that indicate that the sentence
has importance, are given a higher score. You then choose a percentage
of the highest-scoring sentences to display in the summary.
AutoSummarize works best on well-structured documents such as
reports, articles, and scientific papers.
After you install Microsoft Office 2003 Proofing Tools, you can summarize
documents in a different language the same way you do in your
language, if you have enabled editing for the language. If a document
contains text in more than one language, AutoSummarize generates a
summary in the language used most frequently in the document.
For information about automatically summarizing a document, see Word
Help.
Note AutoSummarize may not be available, depending on the language
you are working in.
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Turn automatic language detection on or off
Microsoft Office Word 2003 can automatically detect the language of text
and use the appropriate spelling and grammar dictionaries, punctuation
rules, sequencing, consistency, and sorting conventions for that
language. This provides a convenient way to perform certain tasks, such
as checking spelling and grammar, automatically as you type.
For a list of languages that Word 2003 can automatically detect, see
Word Help.
1. Enable editing for the language.
2. In Word, point to Language on the Tools menu, and then click
Set Language.
3. Select or clear the Detect language automatically check box.
If you turn on automatic language detection, the status bar
indicates the language of the text that the insertion point is
positioned in.
Tips

Turn the word breaker on or off
Although Simplified Chinese, Traditional Chinese, Japanese, and Korean
do not use blank spaces to delineate words, you may want to select
words when working in these languages. For this reason, Microsoft
Office 2003 Proofing Tools includes a word breaker for these languages.
When you turn on the word breaker, it separates continuous characters
into “words” that you can select by dragging or by double-clicking them.
The word breaker is available in Microsoft Office PowerPoint 2003,
Microsoft Office Publisher 2003, and Microsoft Office Word 2003.
1. On the Tools menu, click Options.
2. Click the Edit tab.
3. Select or clear the When selecting, automatically select
entire word check box.
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Change the direction of vertical text
By using Microsoft Office PowerPoint 2003, Microsoft Office
Publisher 2003, and Microsoft Office Word 2003, you can change the
direction of Simplified Chinese, Traditional Chinese, Japanese, and
Korean text in the main text area of a document.
1. If you are using PowerPoint or Publisher, add the text direction
button to a toolbar if you haven't yet done so.
How?
2. Select the text.
3. Do one of the following:
In PowerPoint, click Change Text Direction
the toolbar you added the button to.
In Publisher, click Text Direction
you added the button to.

on
on the toolbar

In Word, click Text Direction on the Format menu.

Check the sequence of Indic or South Asian text
If you install the proofing tools for the appropriate Indic or South Asian
language, you can automatically check the sequence of text in that
language by using Microsoft Office Word 2003.
1. In Word, click Options on the Tools menu.
2. Click the Complex Scripts tab.
3. Select the Use sequence checking check box.
4. If you want Word to replace text for you while checking the
sequence of text, select the Type and replace check box.

Automatically detect variations of a language in Word
On its own, automatic language detection can detect whole languages at
one time, not individual variations of a language. However, if you tend to
use different variations of a particular language, such as British English
and U.S. English, and you want to be able to detect them both, try the
following:
1. Enable editing for the variation of the language that you use
most often.
For example, if you use U.S. English more than British English,
enable English (U.S.) for editing. This tells the program to use
U.S. English when it is distinguishing between English and other
languages.
2. By using the Control Panel, install the appropriate keyboard for
the lesser-used variation of the language. You should now have
two keyboards available, and you can switch between them
using the keyboard layout indicator on the Language bar or
Windows taskbar (at the lower right of the screen).
3. In Microsoft Office Word 2003, type your text as usual. When
you are ready to type in the alternate variation of that language,
use the keyboard layout indicator on the Language bar or
Windows taskbar to switch to a different keyboard layout, and
then continue typing.
For example, type your text using the English (U.S.) keyboard
layout, but when you are ready to type in British English, switch
the keyboard layout to English (United Kingdom) by using the
keyboard layout indicator on the Language bar or Windows
taskbar.
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About working with Arabic text
In addition to proofing tools such as the spelling checker and grammar
and style checker, Microsoft Office 2003 Proofing Tools provides tools
designed specifically for working with Arabic text in Microsoft Office 2003
programs.

Text direction
When working with Arabic text or text in any right-to-left language, you
can change the direction of text, paragraphs, cells, and page layouts by
using the left-to-right and right-to-left options on the Format menu. For
text, paragraphs, cells, and page layouts that are primarily in Arabic, use
a right-to-left setting; otherwise the text will not be laid out as expected.
This setting is different from the right-aligned setting for other languages,
such as English.
Note The right-to-left options are available on the Format menu only if
you enable editing of one or more right-to-left languages.
For more information about formatting right-to-left text, such as setting
the direction of sections and tables, by using a specific Office program,
see Help for that program.

Arabic text translation
Office Proofing Tools includes translation dictionaries that enable you to
translate Arabic text in an Office document into English, or vice-versa.
Translate text
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About working with Hebrew text
In addition to proofing tools such as the spelling checker, Microsoft
Office 2003 Proofing Tools provides tools designed specifically for
working with Hebrew text in Microsoft Office 2003 programs.

Text direction
When working with Hebrew text or text in any right-to-left language, you
can change the direction of text, paragraphs, cells, and page layouts by
using the left-to-right and right-to-left options on the Format menu. For
text, paragraphs, cells, and page layouts that are primarily in Hebrew,
use a right-to-left setting; otherwise the text will not be laid out as
expected. This setting is different from the right-aligned setting for other
languages, such as English.
Note The right-to-left options are available on the Format menu only if
you enable editing of one or more right-to-left languages.
For more information about formatting right-to-left text, such as setting
the direction of sections and tables, by using a specific Office program,
see Help for that program.

Hebrew text translation
Office Proofing Tools includes translation dictionaries that enable you to
translate Hebrew text in an Office document into English, or vice-versa.
Translate text
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About working with Japanese text
In addition to proofing tools such as the grammar and style checker and
AutoCorrect list, Microsoft Office 2003 Proofing Tools provides tools
designed specifically for working with Japanese text in Microsoft
Office 2003 programs.

Japanese Input Method Editor (IME)
By using the Japanese Input Method Editor (IME), which is available on
the Language bar, you can enter Japanese text phonetically, in a variety
of character types, in Office documents. You can also specify how you
want to enter that text.
Enter Japanese text
For more information about using the Japanese IME, see Help for that
IME.

Japanese Consistency Checker
By using the Japanese Consistency Checker, you can identify instances
in a document where different characters are used for words with the
same meaning. You can then make sure you use characters consistently
by selecting the appropriate characters from the suggested revisions.
The consistency checker is available only in Microsoft Office Word 2003.
Identify and change inconsistencies
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About working with Korean text
In addition to proofing tools such as the spelling checker and grammar
and style checker, Microsoft Office 2003 Proofing Tools provides tools
designed specifically for working with Korean text in Microsoft
Office 2003 programs.

Korean Input Method Editor (IME)
By using the Korean Input Method Editor (IME), which is available on the
Language bar, you can enter Korean text in Office documents. You can
also specify how you want to enter that text.
Enter Korean text
Tip
For more information about using the Korean IME, see Help for that IME.

Hangul Hanja converter
By using the Hangul Hanja converter, you can convert text in a document
from Hangul to Hanja or from Hanja to Hangul. The converter is available
in Microsoft Office PowerPoint 2003, Microsoft Office Publisher 2003,
and Microsoft Office Word 2003.
Convert Hangul to Hanja or Hanja to Hangul
Select Hangul and Hanja conversion options
Tip

Hanja dictionary
By using the Hanja dictionary, you can view detailed information, such as
the pronunciation, meaning, and the number of strokes for Hanja in a
document. The dictionary is available in Microsoft Office
PowerPoint 2003, Microsoft Office Publisher 2003, and Microsoft Office
Word 2003.
Find Hanja in the Hanja dictionary
Tip
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About working with Simplified Chinese text
In addition to proofing tools such as the grammar and style checker and
AutoCorrect list, Microsoft Office 2003 Proofing Tools provides tools
designed specifically for working with Simplified Chinese text.

Simplified Chinese Input Method Editor (IME)
By using the Simplified Chinese Input Method Editor (IME), which is
available on the Language bar, you can enter Simplified Chinese text in
Office documents. You can also specify how you want to enter that text.
Enter Simplified Chinese text
For more information about using the Simplified Chinese IME, see Help
for that IME.

Text converter
By using the text converter tool, you can convert text from Simplified
Chinese to Traditional Chinese or from Traditional Chinese to Simplified
Chinese. This tool is available only in Microsoft Office Word 2003.
Convert text
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About working with Traditional Chinese text
In addition to proofing tools such as the grammar and style checker and
AutoCorrect list, Microsoft Office 2003 Proofing Tools provides tools
designed specifically for working with Traditional Chinese text.

Traditional Chinese Input Method Editor (IME)
By using the Traditional Chinese Input Method Editor (IME), which is
available on the Language bar, you can enter Traditional Chinese text in
Office documents. You can also specify how you want to enter that text.
Enter Traditional Chinese text
For more information about using the Traditional Chinese IME, see Help
for that IME.

Text converter
By using the text converter tool, you can convert text from Traditional
Chinese to Simplified Chinese or from Simplified Chinese to Traditional
Chinese. This tool is available only in Microsoft Office Word 2003.
Convert text
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Troubleshoot setup
I completed the setup wizard, but I don't see Office Proofing Tools in the
list of programs on the Start menu
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Troubleshoot fonts
Word displays fonts incorrectly.
I do not see some fonts in the Font list.
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Troubleshoot printing
I'm having trouble printing in some languages.
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Troubleshoot spelling and grammar checkers
The Microsoft Office 2003 program I am working in doesn't
automatically check the spelling of text.
I don't want to check the spelling or grammar of some text.
I want to change the language for checking spelling in an Office 2003
program.

